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Overview

Stellar Phoenix DB2 Recovery software recovers corrupted databases that are created by
using IBM DB2 (UDB) v8. DB2 should be installed on a computer in which Stellar Phoenix
DB2 Recovery software needs to be installed. This software repairs a corrupted database
and creates a new database. DB2 stores a database at the location specified during the
configuration of the database.

There should be no active connection with the database that needs to be recovered. All
connections should be closed and then recovery process should be started.

Stellar Phoenix DB2 Recovery software automatically selects and displays all databases
that are attached to DB2. After scanning process Stellar Phoenix DB2 Recovery software
shows the original contents of the selected database. You can also select and recover
corrupted databases manually by using the Stellar Phoenix DB2 Recovery software.

Stellar Phoenix DB2 recovery software recovers and attach the recovered databases to
DB2 automatically. You can store the repaired databases at the location where the
database is previously stored or at specified location.

Key Features of Stellar Phoenix DB2 Recovery:
* Recovery of corrupted DB2 databases
*  Preview of contents of databases
e Supports IBM DB2 (UDB) v8
« Recovers tables, views, triggers, schemas, containers and buffer pools
« Recovers user-defined distinct data types
* Recovers primary and foreign key associated with tables
» Automatic selection of databases that are attached to DB2
e Saves recovered databases at preferred location
e Manual selection of databases
Stellar Phoenix DB2 Recovery Limitations:
¢ Tables with clustering cannot be recovered
¢ Tables with partitioning cannot be recovered

* Indexes on tables cannot be recovered
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e Columns having user-defined structure data types cannot be recovered

e Supports only Single Partitioned DB2 database
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Getting Started

You should install DB2 on a computer in which Stellar Phoenix DB2 Recovery is installed.
The selection and recovery of databases that are attached to DB2 is easy to implement.
You will only need to specify the database that needs to be recovered from the list of
databases. The Stellar Phoenix DB2 Recovery software scans and recover the selected
database, in addition, it allows you to specify a different location to save the recovered
database.

You can also select and recover databases that are not attached to DB2. You will need to
specify files that are required to recover the corrupted database.

You can select individual or multiple tables from a recovered database such that only
selected tables should be saved. The demo version of the software shows only tables and
their contents. In order to save repaired databases you will need to register the software.

e Installation procedure

e Order and Register

* User interface
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Installation Procedure

Before installing the Stellar Phoenix DB2 Recovery software ensure that your computer
meets the minimum system requirements.

Minimum System Requirements:
+ Operating System: Windows 2000/2003/XP
« RAM: 1GB RAM per 20 GB of database
« Hard Disk: 10MB of free space
- IBM DB2 (UDB) version 8

To install Stellar Phoenix DB2 Recovery:

1. Double-click spdr.exe file to start the setup process. The Setup - Stellar Phoenix
DB2 Recovery dialog box opens. Click Next.

2. Inthe License Agreement screen, select | accept the agreement option. The Next
button will be enabled. Click Next.

3. Inthe Select Additional Tasks screen, check the required check boxes. Click Next.

4. In the Select Destination Location screen, provide the path by using Browse button
where the setup files will be stored. Click Next.

5. Inthe Start Menu Folder screen, provide the path by using Browse button where
the program's shortcuts will be stored. Click Next.

6. Inthe Ready to Install screen, review the settings. Click Back to change settings.
After confirming, the settings click Install. The Installing screen shows the
installation process.

7. After completing the process, the Completing the Stellar Phoenix DB2 Recovery
Setup Wizard screen opens. Click Finish.

To start the software, do one of the following:

e Click Start, point to All Programs, select Stellar Phoenix DB2 Recovery, and
then click Stellar Phoenix DB2 Recovery.

»  Double-click the shortcut icon of Stellar Phoenix DB2 Recovery on the desktop.

«  Click quick launch icon of Stellar Phoenix DB2 Recovery on the taskbar.
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Order and Register

To know how to order and register:
e How to Order?

« How to Register?
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How to Order

The software can be purchased by making payments online using a credit card. Please visit

http://www.stellarinfo.com/db2-recovery-prices.htm for more information and to

place an order.

Alternatively, if the demo version is installed then you can register the demo version. To
register the demo version, on the Tools menu select Activate Online or Manual Registration
to start the registration process.

Once the registration is complete, an activation serial number along with activation details is
sent through email. This activation serial number is required to register the software.


http://www.stellarinfo.com/db2-recovery-prices.htm
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How to Register?

Notes:

If the software is downloaded from http://www.stellarinfo.com/db2-

recovery.htm (thatis, ESD version), for the full functionality, the

product must be registered using Serial Number (received through
email after purchasing the product).

If the software is installed using the product installation CD (i.e., BOX

. . o
version),hardware lock[ “ ] is mandatory for the functioning of the

software which is available with the software kit.

After

purchasing the software, you will receive the serial number, which is required to

register the software. The serial number will be verified during the registration process and if
the serial number is valid then the software will be registered.

The software can be registered in different ways. These are the methods by using which
you can register the software:

Over internet

You should have the serial number, which is received after purchase of the software.
On entering the serial number it is verified by license server and on verification the
software will be registered.

Manual Activation

You will need to generate a PHG.TXT file and mail the .txt file to
support@stellarinfom.com. After verifying the serial number and purchase details of
the software, the site key will be delivered to you at your email address. This site key
is used to register the software manually.

Using Email

If the registration of the software by using Online Registration or Manual Activation is
not successful then you can still register the software by using email. An email will be
send to support@stellarinfo.com either automatically or manually by the Stellar
Phoenix - Electronic Software Registration wizard. The software will be registered
automatically, when Internet connection is available on your computer.


mailto:support@stellarinfom.com
http://www.stellarinfo.com/db2-recovery.htm
http://www.stellarinfo.com/db2-recovery.htm
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Registration Over Internet

To register the software over Internet:

1. On the Tools menu, select Activate online. The Stellar Phoenix dialog box opens,
check the | have the registration key checkbox and select Online registration
option. Click OK, and then click Yes.

2. In the Welcome to Stellar Phoenix - Electronic Software Registration wizard, click
Next.

3. Type the Serial number (received through email after purchasing the product) in the
Serial number text box. Click Next.

Stellar Phoenix - Electronic Repistration Wizard

To complete the sofbware regizteabion you need to enter the seqal numbeer

The zenal numbes haz been sent to you through email by our
payment-processng agent, immediately after purchaze.

Senal numbes
2083 7607 D3E2 FTEA B

[ Cancel | | < Previous | | Mest > |

4. The software would automatically communicate with license server and register the
software. Click Finish to complete the registration process.

Note: If online activation is failed then you can send the serial
number, which is received after purchase of the software, to

support@stellarinfom.com for registering the software by using manual
activation.
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Manual Activation

To register the software by using manual activation process:

1.

On the Tools menu, select Manual Activation. The Stellar Phoenix dialog box
opens, check the | have the registration key checkbox and select Online
registration option. Click OK, and then click Yes.

In the Welcome to Stellar Phoenix - Electronic Software Registration Wizard,
click Cancel. In the Stellar Phoenix dialog box, click Yes.

In the Manual Registration screen, enter the serial number that is received after
the purchase of the software. Click Next.

A PHX_REG.txt file will be created on desktop. Email the text file to the email
support@stellarinfom.com address. You can click the link given in the screen to
start to automatically compose the email for the given email address. Click
Finished.

After verifying the purchase details, you will receive the site key that is required
to register the software by using manual activation.

When you receive the site key, open Stellar Phoenix DB2 Recovery, On the
Tools menu, select Manual Activation. The Stellar Phoenix dialog box opens,
check the I have the registration key checkbox and select Manual
Registration option. Click OK.

In the Manual Registration screen, type the site key, which is received after
sending the PHX_REG.txt file. Click Validate to register the software.


mailto:support@stellarinfom.com
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Registration by using Email
To register the software by using email

If you receive the given below error dialog box, then click OK to start the registration
process by using email.

L] The electronic suthorization wizand could not communicste with the icense server over the internet. However, your
1 authorizatson request can stil be processed.

Simply press O snd you will be taken through the process of registering through emall.

[ o< ]

In the Stellar Phoenix - Electronic Registration Wizard, click Next if you want to send email
automatically for requesting the site key or check the Manually send email checkbox if you
want to send the email manually.

+ Manually Send Email

1. In the Stellar Phoenix - Electronic Registration Wizard, check the Manually
send email checkbox and click Next.

2. Follow the instructions as given in the Stellar Phoenix - Electronic
Registration Wizard. After clicking Finish, click send button in your email
client to send the email.

The software will be registered automatically, when Internet connection is available
on your computer.

+ Automatically sending email

1. In the Stellar Phoenix - Electronic Registration Wizard, click Next. Type your
email address in the textbox. The unlocking code will be sent to this email
address. Click Next.

10
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Stellar Phoenix - Electronic Registration Wizard

Erbed younr e scddress bedow and prazs "MNead™. Thiz iz the addiess whers
the: undocking code vall be sent
johwon. massonEspahon, coml

[ Cancel ] [ < Previous ] I Mext > I

2. In the Verify Email Address screen, verify the email address you have
entered and click Yes.

Verify Email Address E|

Fleaze take a moment to verify that your email address is comrect. IF it iz
incorect, your unlocking code cannot be gent o pou,

ou entered:
johwon_maszsoni@yahoo. com

|z this cormect?

es l [ Mo

3. If your email client is blocking the process the following dialog box appears, it
depends ion your email client here Microsoft Outlook example is given. Click
Yes, and then click Finish.

Microsoft Office Outlook

& program is trying ko access e-mail addresses vou have
stored in Dutlook., Do wou want to allow this?

If this is unexpected, it may be a virus and you should
choose "Ma",

[ ] allow access For

| ves || me || Hew

The email will be automatically send. The software will be registered automatically, when
Internet connection is available on your computer.

11
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Note: If you click Previous button then you will need to type the
serial number, which is received after purchase of the software and
email address, the remaining procedure is same as mentioned above.

12
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User Interface

Stellar Phoenix DB2 Recovery software has a very easy to use Graphical User Interface
(GUI). This software includes many features that helps in recovering corrupted DB2
databases. The main user interface of Stellar Phoenix DB2 Recovery software is as shown
below.

" Stallar Phaenix DB Recovery MEES

o Il 0 24 6 ol i

O Seolar Moo D62 Revswery

Stellar Phoenix DB2 Recovery

Pl okt of St pbase bir pevizeney,

= RS S e,

Mete) In e Domo version, you cannol ainve repained fle Bt you can privie the fle Setails in the fight pana,

] Pt P DB Rer ¥ 1 P AT DO Gt b Pt

Rrady

The main user interface is a three-pane structure. The left-pane shows tables of a
database. The right-pane show records of a table selected from the left-pane. The bottom-
pane shows ongoing processes such as repair process start time, repair process finish time.

The main user interface includes:
¢ Menubar

¢« Toolbar

13
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The Menubar of the Stellar Phoenix DB2 Recovery includes the given below menus and

items:

« File

(]

o View

O

O

o Tools

Open Database: to open DB2 databses
Start Repair: to start repairing process
Stop: to stop an ongoing repairing process

Exit: to close the Stellar Phoenix DB2 Recovery software

Toolbar: to view toolbar, select toolbar to be shown in main user interface

Status Bar: to view Status Bar, select Status Bar to be shown in main user
interface

Message Log: to view Message Log, select Message Log to be shown in
main user interface

Save Log: to save the record of all processes that are performed by Stellar
Phoenix DB2 Recovery software in a text file

Clear Log: to clear the record of all processes that are performed by Stellar
Phoenix DB2 Recovery software

o Activation

o Help

14

Activate Online: to register the Stellar Phoenix DB2 Recovery software
online

Manual Registration: to register the Stellar Phoenix DB2 Recovery
software manually

Stellar Phoenix DB2 Recovery Help: to open user guide of the Stellar
Phoenix DB2 Recovery software
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Purchase Stellar Phoenix DB2 Recovery Online: to purchase the Stellar
Phoenix DB2 Recovery software online that is to purchase activation keys

Updates: to download new updates for the Stellar Phoenix DB2 Recovery
software

About Stellar Phoenix DB2 Recovery: to view End User License

Agreement and general information about the Stellar Phoenix DB2
Recovery software

15
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Toolbar

The toolbar of Stellar Phoenix DB2 Recovery software includes these tools:

Open database: use this icon to locate and open database that needs to be
repaired

Start Repair: to start repairing a selected database

~

Help: to open user guide of the Stellar Phoenix DB2 Recovery software

2

Updates: to download latest updates for the Stellar Phoenix DB2 Recovery
software

L

-
'-C",-,‘I‘E"

Purchase: to purchase the Stellar Phoenix DB2 Recovery software

.

About: to view End User License Agreement (EULA) and general information

16
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Using the Software

Stellar Phoenix DB2 Recovery has easy to use Graphical User Interface (GUI). You can
easily use this software to recover corrupted DB2 databases.

You should install DB2 on the computer on which Stellar Phoenix DB2 Recovery is
installed. This software shows all contents of the recovered databases. After recovery of a
database, the recovered database is automatically attached to DB2 database.

* Recovering DB2 databases

« Recovering databases from default storage location

e Recovering databases manually

17
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Recovering Databases

DB2 stores all database files at the location specified during the creation of databases.
When you create a database in DB2, a folder DB2 is created at the specified location. This
folder contains NODEQOOO folder, the NODEOOOQO folder contains SQLDBDIR and data
folders. The data folders such as SQL00001, SQL0O0002 contains all files such as
containers, log file related to a database.

Stellar Phoenix DB2 Recovery requires SQLDBDIR, data folder and corresponding
containers to recover a database. If a database is attached to DB2 then Stellar Phoenix
DB2 Recovery automatically select the required files and recovers the selected database.
You will only need to specify the database from the list of databases displayed by Stellar
Phoenix DB2 Recovery software.

However, If a database is not attached to DB2 then you will need to specify the exact
location/path of all required files for the successful recovery of the database. You will need
to specify the path of SQLDBDIR folder, data folder of the database that needs to be
recovered and corresponding containers. Therefore, before recovering a database that is
not attached to DB2 you should plan accordingly to recover the database.

Based on the availability of database that is whether database is attached or not, Stellar
Phoenix DB2 Recovery software provides two options for recovering databases.

* Recovering databases that are attached to DB2

¢ Recovering databases manually

18
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Recovering Databases from Default Storage
Location

Stellar Phoenix DB2 Recovery software automatically displays databases that are attached
to DB2. You will only need to select the database, which needs to be recovered, from the
list of databases displayed by Stellar Phoenix DB2 Recovery software. Stellar Phoenix DB2
Recovery software provides the Repair corrupt database stored at default location option to
start recovering databases that are attached to DB2.

Repair corrupt database stored at default location

In this recovery mode, all databases that are attached to DB2 are automatically displayed
by Stellar Phoenix DB2 Recovery software. You will only need to select the database from
the list of databases. All required files are automatically retrieved by Stellar Phoenix DB2
Recovery software. However, all files should exist on the same computer.

After scanning process all tables of the selected database is shown in the Stellar Phoenix
DB2 Recovery window. You can save all tables or required tables of the database. A new
database is created when you save the database. All files are automatically created for the
selected database. In addition, you can save the recovered database to the same location
from where database is selected or originally stored or at different location as per your
preference. Moreover, you can save container to other location than the location where data
folder and SQLDBDIR folder is saved. The recovered database would automatically
attached to DB2. To select and recover database:

e Selecting database

e Saving scanned database

Note: The Repair corrupt database stored at default location
option would be enable if DB2 is installed on the same computer in
which Stellar Phoenix DB2 Recovery software is installed.

19
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Selecting Database

Stellar Phoenix DB2 Recovery software can display all databases automatically that are
attached to DB2.

To select a database that is attached to DB2:

20

Eas
On the File menu, click Select Database or click ﬁ icon.
Select Repair corrupt database stored at default location option and click OK.

All the databases that are attached to DB2 are displayed under the Database Name
list.

Click a database name to select the database. Database will be scanned and all
tables of the database is displayed after scanning process.

All tables that exists in the selected database will be listed under the root node in
the left pane. The root node name is same as the path of the selected database. All
tables are displayed under the database's name tree. Click a table name to view its
contents. You can view contents of all tables of the database that is scanned.

Save the scanned database either to original or other location.

Notes:

« The Repair corrupt database stored at default location
option would be enable if DB2 is installed on the same computer
in which Stellar Phoenix DB2 Recovery software is installed.

e There should be no active connection with the database that
needs to be recovered. All connections should be closed and
then recovery process should be started.
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Saving Scanned Database

After scanning process is completed, you can save the recovered database at original
location or at some other location. All files will be stored under the same folder name
prefixed with 'R’ folder at the saved location.

To recover and save the scanned database:

1. Inthe left pane of Stellar Phoenix DB2 Recovery window, check the checkboxes of
tables that needs to be recovered and saved.

2. On the File menu, select Start Repair or click M icon.

3. In the Select Destination screen, select:

Default Location

Database will be stored at the same location where the database is originally
stored.

Select New Location

Database will be stored at the specified location. Click the Select Destination
Drive combo box and select a drive where database should be stored.

Click OK. Only the SQLDBDIR and data folder will be saved at the specified location.
You will need to specify the path for containers also.

4. In the Select Destination Location of containers dialog box, specify the path where
containers should be saved.

L]

Select Path

Click on a container name and click Select Path. Specify the location where
the selected container should be saved. Use this option to save containers at
different location.

Map Drive

Use map drive to change the drive of all containers that are stored at same
drive. Only drive will be changed not the path. For example, if containers were
stored at C: then map drive for one containers. All containers that were stored
at C: will be automatically mapped to the new drive. To map drive:

1. Click on a container name, and the click Map Drive. In the Map Drive
dialog box, all drives where containers were previously stored are
shown.

21
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2. Click next to a drive name. In the combo box, select the drive that
should be mapped in place of original drive.

5. After specifying path, click OK. Database will be processed and saved to the
specified location.

22
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Recovering Databases Manually

Stellar Phoenix DB2 Recovery software allows you to recover databases that are not
attached to DB2. You can select databases manually, recover and save at your preferred
location. Stellar Phoenix DB2 Recovery provide the Manual Selection of database for
recovery option that allows you to select databases that are not attached to DB2.

Manual Selection of database for recovery

In this recovery mode, you will need to specify the exact path of all required files to recover
a database. You will need to specify the exact path of SQLDBDIR folder, data folder and
container of the database that needs to be recovered. All container and data folder should
be available for recovering the database by manual process.

While recovering a database by using manual process you will need to specify the exact
path of the root folder that contains SQLDBDIR and data folder. The SQLDBDIR and data
folder should exist in the same folder. You should create or specify the exact path of the
root folder that contains these two folders. When you select the root folder that contains
these two folders, Stellar Phoenix DB2 Recovery software automatically shows the
corresponding containers of the selected database. In addition, the original path of
containers is also shown. You can view containers name and browse to locate the required
containers. In addition, you can map drive of containers if the newly created directory
structure or hierarchy, which contains all the required containers, is same as original
hierarchy.

After scanning process all tables of the selected database is shown in the Stellar Phoenix
DB2 Recovery window. You can save all tables or required tables of the database. A new
database is created when you save the database. In addition, you can save the recovered
database to the same location from where database is selected or originally stored or at
different location as per your preference. Moreover, you can save containers to other
location than the location where data folder and SQLDBDIR folder is saved. The recovered
database would automatically attached to DB2.

It is recommended that you should plan before starting manual recovery of a database. This
would help you to recover the database easily and successfully.

¢ Planning manual recovery

¢ Manually selecting database

* Recovering and saving database

23
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Planning Manual Recovery

You will need to specify the root folder, which contains SQLDBDIR and data folder, to select
and recover the required database. You will need to copy data folder and SQLDBDIR under
a folder then specify the exact path of the folder that contains these two folders. Stellar
Phoenix DB2 Recovery software automatically shows the containers of the selected
database. You should plan before performing manual recovery. These are the preliminary
steps to perform manual recovery:

Planning manual recovery:
1. Search and locate the SQLDBDIR folder.
2. ldentify the data folder of the database, which needs to be recovered.

3. Create a new folder in a drive. It is recommended that you should create the same
directory structure, as original directory structure of the database, at new location.

4. Copy SQLDBDIR and data folder of the database in the new folder.

5. Start manual recovery process, specify the exact path of the new folder that
contains SQLDBDIR and data folder of the database.

6. Specify path of each container.
7. Select the saving location. Specify location for containers also.
8. Save the database.

By default, Stellar Phoenix DB2 Recovery software shows the path of containers where they
were originally stored. You should specify the exact path of containers to recover database
successfully. You can specify path for each container individually or map drive to specify the
location of containers. All containers should be in stored in the same hierarchy as original.
Mapping the drive for one container automatically maps the drive of all containers.

However, mapping a drive only changes the drive not the exact path. If containers are
stored at different location then specify path of each containers individually.

You should know the exact data folder of the database that needs to be recovered.
However, if you do not know that which data folder contains the required database then still
you can recover the required database. You will need to select and scan all database
folders one by one in Stellar Phoenix DB2 Recovery software. After scanning, all contents
of the database will be displayed by Stellar Phoenix DB2 Recovery software. You can
identify the correct database by viewing contents.

In addition, the database name is also displayed by the software. The tree generated after
scanning of database has the root node named as the path of the database followed by the
name of database. For example, C:\\DB2\Mydatabase. The last parameter is the name of
database.
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Manually Selecting Database

You should plan before performing manual recovery of databases. You can recover DB2
databases by manually selecting different database's files. These files and folders are
required to manually select a database:

< SQLDBDIR
< Data Folder or database folder
To manually select a database:

1. Copy SQLDBDIR and data folder of the database in a folder.

L@

2. On the File menu, select Select Database or click “*== icon on the toolbar.
Select Manual Selection of database for recovery option.

3. Click Browse, locate and select the folder under which SQLDBDIR and data folder
of the database is stored. Click OK.

4. In the Select Location of Containers dialog box, you can view the containers
associated with the selected database.

5. Inthe Select Location of Containers dialog box, specify the exact path of these
containers. Click on a container name and then click Select Path. In the Browse for
Folder dialog box, specify the folder location that contain the selected container. If
there are multiple containers then specify path for all containers and then click OK.
In addition, you can map drive to change the path of containers if containers are
stored under same hierarchy as original. If hierarchy is same as original then
mapping a single container would change the path of all containers.

6. All tables are displayed in the main screen of Stellar Phoenix Windows Data
Recovery software. The root node displays the path and name of the database, the
child node shows the authentication level for the database.

7. Click a table name to view its contents in the right-pane.

8. On the File menu, select Start repair or click !EJ icon to start recovering and
saving the database.

Notes:

« The SQLDBDIR and data folder of the database should be in the
same folder. However, containers can be stored at different
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Recovering and Saving Database

After selecting the required database you can recover and save it either to default location
or preferred location. You can select all tables or only required tables under that database
for recovering purpose. You can specify different location to store containers the database
other than the original location.

Stellar Phoenix DB2 Recovery recovers and creates a new database at the destination. All
necessary files and folders are automatically built by the software.

To recover and save database:

1. In the left Check pane of Stellar Phoenix DB2 Recovery window, check the
checkboxes of tables that needs to be recovered and saved.

2. On the File menu, select Start Repair or click M icon.
3. In the Select Destination screen, select:
» Default Location
Database will be stored at the default database storage location of DB2.
* Select New Location

Database will be stored at the specified location. Click the Select Destination
Drive combo box and select a drive where database should be stored.

Click OK. Only the SQLDBDIR and data folder will be saved at default or new
location. You will need to specify the path for containers also.

4. In the Select Destination Location of containers dialog box, specify the path where
containers should be saved.

« Select Path

Click on a container name and click Select Path. Specify the location where
the selected container should be saved. Use this option to save containers at
different location.

« Map Drive

Use map drive to change the drive of all containers that are stored at same
drive. Only drive will be changed not the path. For example, if containers were
stored at C: then map drive for one containers. All containers that were stored
at C: will be automatically mapped to the new drive. To map drive:
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1. Click on a container name, and the click Map Drive. In the Map Drive
dialog box, all drives where containers were previously stored are
shown.

2. Click Next to a drive name. In the combo box, select the drive that
should be mapped in place of original drive.

5. After specifying path, click OK. Database will be processed and saved to the
specified location.
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Log Report
Log window shows the progress of the current process. The log window displays messages
such as indicating the beginning of the process, end of the process, name of the corrupted
file.
« To enable log window
0 Onthe View menu, select Message log

o To save log information

0 On the Tools menu, select Save Log. In the Save As dialog box, specify
the destination where log file should be saved. Click Save.

o To clear log information

0 On the Tools menu, select Clear Log.
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Copyright

Stellar Phoenix DB2 Recovery software, accompanied user manual and documentation are
copyright of Stellar Information Systems Ltd., with all rights reserved. Under the copyright
laws, this user manual cannot be reproduced in any form without the prior written
permission of Stellar Information Systems Ltd. No Patent Liability is assumed, however,
with respect to the use of the information contained herein.

Copyright © 1995-2009 by Stellar Information Systems Ltd. INDIA
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Disclaimer

The Information contained in this manual, including but not limited to any product
specifications, is subject to change without notice.

STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANTY WITH REGARD
TO THIS MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN AND
HEREBY EXPRESSLY DISCLAIMS ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE WITH REGARD
TO ANY OF THE FOREGOING STELLAR INFORMATION SYSTEMS LTD ASSUMES NO
LIABILITY FOR ANY DAMAGES INCURRED DIRECTLY OR INDIRECTLY FROM ANY
TECHNICAL OR TYPOGRAPHICAL ERRORS OR OMISSIONS CONTAINED HEREIN
OR FOR DISCREPANCIES BETWEEN THE PRODUCT AND THE MANUAL. IN NO
EVENT SHALL STELLAR INFORMATION SYSTEMS LTD, BE LIABLE FOR ANY
INCIDENTAL, CONSEQUENTIAL SPECIAL, OR EXEMPLARY DAMAGES, WHETHER
BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT OF ORIN
CONNECTION WITH THIS MANUAL OR ANY OTHER INFORMATION CONTAINED
HEREIN OR THE USE THEREOF.
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Trademarks

Stellar Phoenix DB2 Recovery® is a registered trademark of Stellar Information Systems
Ltd.

Windows 2000 Server®, Windows XP®, Windows 2003® and Windows Vista® are
registered trademarks of Microsoft® Corporation Inc.

All Trademarks Acknowledged.

All other brands and product names are trademarks or registered trademarks of their
respective companies.
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License Agreement

Stellar Phoenix DB2 Recovery

Copyright © 1995-2009 by Stellar Information Systems Ltd. INDIA
www.stellarinfo.com

All rights reserved.

All product names mentioned herein are the trademarks of their respective owners.

This license applies to the standard-licensed version of Stellar Phoenix DB2 Recovery.

Your Agreement to this License

You should carefully read the following terms and conditions before using, installing or
distributing this software, unless you have a different license agreement signed by Stellar
Information Systems Ltd.

If you do not agree to all of the terms and conditions of this License then do not copy,
install, distribute or use any copy of Stellar Phoenix DB2 Recovery with which this License
is included, you may return the complete package unused without requesting an activation
key within 30 days after purchase for a full refund of your payment.

The terms and conditions of this License describe the permitted use and users of each
Licensed Copy of Stellar Phoenix DB2 Recovery. For purposes of this License, if you have
a valid single-user license, you have the right to use a single Licensed Copy of Stellar
Phoenix DB2 Recovery. If you or your organization has a valid multi-user license, then you
or your organization has the right to use up to a number of Licensed Copies of Stellar
Phoenix DB2 Recovery equal to the number of copies indicated in the documents issued by
Stellar when granting the license.

Scope of License

Each Licensed Copy of Stellar Phoenix DB2 Recovery may either be used by a single
person or used non-simultaneously by multiple people who use the software personally
installed on a single workstation. This is not a concurrent use license.

All rights of any kind in Stellar Phoenix DB2 Recovery, which are not expressly granted in
this license, are entirely and exclusively reserved to and by Stellar Information Systems Ltd.
You may not rent, lease, modify, translate, reverse engineer, decompile, disassemble or
create derivative works based on Stellar Phoenix DB2 Recovery nor permit anyone else to
do so. You may not make access to Stellar Phoenix DB2 Recovery available to others in
connection with a service bureau, application service provider or similar business nor permit
anyone else to do so.

Warranty Disclaimers and Liability Limitations.
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Stellar Phoenix DB2 Recovery and all accompanying software, files, data and materials are
distributed and provided AS IS and with no warranties of any kind, whether expressed or
implied. In particular, there is no warranty for the quality of data recovered. You
acknowledge that good data processing procedure dictates that any program including
Stellar Phoenix DB2 Recovery must be thoroughly tested with non-critical data before there
is any reliance on it and you hereby assume the entire risk of all use of the copies of Stellar
Phoenix DB2 Recovery covered by this License. This disclaimer of warranty constitutes an
essential part of this License.

In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix
DB2 Recovery in applications or systems where its failure to perform can reasonably be
expected to result in a significant physical injury or in loss of life. Any such use is entirely at
your own risk and you agree to hold Stellar harmless from any and all claims or losses
relating to such unauthorized use.

General

This License is the complete statement of the agreement between the parties on the subject
matter and merges and supersedes all other or prior understandings, purchase orders,
agreements and arrangements. This License shall be governed by the laws of the State of
Delhi, India. Exclusive jurisdiction and venue for all matters relating to this License shall be
in courts and for a located in the State of Delhi, India and you consent to such jurisdiction
and venue. There are no third party beneficiaries of any promises, obligations or
representations made by Stellar herein. Any waiver by Stellar of any violation of this License
by you shall not constitute nor contribute to a waiver by Stellar of any other or future
violation of the same provision or any other provision of this License.

Copyright ©1995-2009 by Stellar Information Systems Ltd. All rights reserved.
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Technical Support

Our Technical Support professionals will give solutions for all your queries related to Stellar
Products.

You can either Call Us or Go Online to our support section
http://stellarinfo.com/esupport/users/kb.php

Support Helpline

Monday - Friday [ 24 Hrs. a day ]

USA (Toll free - Pre Sales Queries) 1-866-554-2512

USA (Post Sales Queries) 1-315-220-6245

UK (Europe) +44-207-993-2293
Germany +49-180-110-105-0051
Worldwide +91-921-395-5509
Skype Id stellarsupport

Email Orders orders@stellarinfo.com

Online Help
= Chat Live with an Online technician
= Search in our extensive Knowledge Base
= Submit Ticket (If our Knowledge Base does not answer your question)

= Login and view Ticket Status (If you already have a valid Ticket with you)
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= Download Documents on Product Usage ( For Registered members only, i.e, user
with login ID. If you are an unregistered user, please visit

http://stellarinfo.com/esupport/users/login.php to create login ID)
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About Stellar

Stellar Information Systems Ltd. is a trusted name in the field of Data Recovery and Data
Protection Software for more than a decade.

We provide the widest range of Data Recovery Products. Our range includes Data
Recovery Software for almost all Operating Systems and File Systems.

Product line:
Data Recovery

A widest range of data recovery software that helps you recover your valued data lost after
accidental format, virus problems, software malfunction, file/directory deletion, or even
sabotage!. More Info >>

File Recovery

The most comprehensive range of file undelete and unerase software for Windows and MS
office repair tools. More Info >>

Email Recovery

A wide range of mail recovery, mail repair and mail conversion applications for MS Outlook,
MS Outlook Express and MS Exchange useful in instances of data loss due to damages
and corruption of Email. More Info >>

Data Protection

A wide range of Prevent Data Loss, Data backup and Hard Drive Monitoring Applications to
ensure complete data protection against hard drive crash. More Info >>

Data Sanitization

Data cleanup and file eraser utility can delete selected folders, groups of files, entire logical
drives, System Traces & Internet traces. Once the data have been removed using Stellar
Wipe - Data File eraser utility, it is beyond recovery limits of any Data Recovery Software or
utility. More Info >>

For more information about us, please visit www.stellarinfo.com

38


http://www.stellarinfo.com/
http://www.stellarinfo.com/file-eraser.htm
http://www.stellarinfo.com/prevent-dataloss.htm
http://www.stellarinfo.com/mail-recovery.htm
http://www.stellarinfo.com/undelete.htm
http://www.stellarinfo.com/disk-recovery.htm

	Overview
	Key Features of Stellar Phoenix DB2 Recovery:
	Stellar Phoenix DB2 Recovery Limitations:

	Getting Started
	Installation Procedure
	Minimum System Requirements:
	Operating System: Windows 2000/2003/XP
	RAM: 1GB RAM per 20 GB of database
	Hard Disk: 10MB of free space
	IBM DB2 (UDB) version 8

	To install Stellar Phoenix DB2 Recovery:
	To start the software, do one of the following:

	Order and Register
	To know how to order and register:

	How to Order
	How to Register?
	Over internet
	Manual Activation
	Using Email

	Registration Over Internet
	To register the software over Internet:

	Manual Activation
	To register the software by using manual activation process:

	Registration by using Email
	To register the software by using email
	Manually Send Email
	Automatically sending email


	User Interface
	Menubar
	File
	View
	Tools
	Activation
	Help

	Toolbar
	Using the Software
	Recovering Databases
	Recovering Databases from Default Storage Location 
	Repair corrupt database stored at default location

	Selecting Database
	To select a database that is attached to DB2:

	Saving Scanned Database
	To recover and save the scanned database:
	Default Location
	Select New Location
	Select Path
	Map Drive


	Recovering Databases Manually
	Manual Selection of database for recovery

	Planning Manual Recovery
	Planning manual recovery:

	Manually Selecting Database
	To manually select a database:

	Recovering and Saving Database
	To recover and save database:
	Default Location
	Select New Location
	Select Path
	Map Drive


	Log Report
	To enable log window
	To save log information
	To clear log information

	Legal Notices
	Copyright 
	Copyright © 1995-2009 by Stellar Information Systems Ltd. INDIA

	Disclaimer 
	Trademarks 
	License Agreement 
	Your Agreement to this License
	Scope of License
	Warranty Disclaimers and Liability Limitations.
	General

	Technical Support 
	Support Helpline
	Monday - Friday [ 24 Hrs. a day ]

	Online Help
	About Stellar 
	Product line:
	Data Recovery
	File Recovery
	Email Recovery
	Data Protection
	Data Sanitization



